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Creating QGIS2 Web Maps

Web Maps is a great medium to publish your GIS data to their web and make it accessible
by other users. Creating a web map is a very different process than creating one in a GIS.
GIS users are typically aren't web programmers and it presents a challenge when one needs
to create a web map that is of the same quality as a map creating in a GIS.

Fortunately, there are tools available to easily translate your work in QGIS to web maps.
In this Hands-on Session, you will learn how to use the QGIS2Web plugin to create a web
map using Open Layers or Leaflet libraries from your QGIS project.

Overview of the task

We will create a open layers web map for Historical Tsunami Events

Other skills you will learn

® How to use Edit Widgets in QGIS to hide certain fields and set custom types.
¢ How to apply symbology to a vector layer feature.

¢ Creating popups with feature attributes values that appear on mouse over.
Get the data

We will use the Historical Tsunami Events dataset provided by INCOIS.

Download the Day-3ExampleDataset Folder.

which contains Historical Tsunami Events, Continents, etc shapefiles and World Earth Tiff
Files

For convenience, you may directly download a copy of the datasets from the links below:
Day-3ExampleDataset.zip

Data Source [INCOIS]
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Procedure:

1) Open QGIS and go to Layer » Add Vector Layer. Browse to the location
“Day-3ExampleDataset\” and select the file HistoricalTsunamiEvents.shp

Click Add and the layer HistoricalTsunamiEvents to “yourchoiceofname” by right click

Rename Layer option; and also Add Raster Layer and select the file wsiearth.tif and

save the QGIS Project as DemoWebMap.qpz

@ Untitled Project — QGIS
Project Edit View Settings Plugins Vector Raster Database Web Mesh Processing Help

D & 3 [3) ® Data Source Manager Ctrl+L
®QV. 2™ Create Layer
SN  Add Laye »
Browser i
Vo i@y e EmbedLayers and Groups..
[ Favorite: Add from Layer Definition File...
BB » [ Spatial & 11 Georeferencer...
9, |* [6] Home Copy Style
» LI Ca(sys]
73 b /DA Paste Style
B | @ Geopack  CopyLayer
%7 | spatiali{ [ Paste Layer/Group
@R @ postgres Open Attribute Table F6
% Filter Attribute Table >
J @ Oradle Toggle Editing
@- @ WMs/W | Save Layer Edits
BB Vector T Current Edits »
b 552 V7 Tiled
Save As.
Layers
vanE Save As Layer Definition File
["1 Remove Layer/Group Ctrl+D
Duplicate Layer(s)
Set Scale Visibility of Layer(s)
Set CRS of Layer(s) Ctrl+Shift+C
Set Project CRS from Layer
Layer Properties.
Filter Ctrl+F
Labeling
Show in Overview
©0 Show All in Overview
Q. Type to locate (CulL "8 Hide All from Overview

+ Add Vector Layer...
¥, Add Raster Layer...

dd Mesh Layer...

9 Add Delimited Text Layer...

@, Add PostGIS Layers...

/4 Add Spatialite Layer...

JB Add MS SQL Server Layer...

@, Add Oracle Spatial Layer...

B, Add SAP HANA Spatial Layer...
(/A Add/Edit Virtual Layer...

€8 Add WMS/WMTS Layer...

£2 Add XYZ Layer...

@3 Add WCS Layer...

& Add WFS Layer...

&%) Add ArcGIS REST Server Layer...

| Add Vector Tile Layer...
3 s

92 Add Point Cloud Layer...
@3 Add GPX Layer...

Ctrl+Shift+V
Ctrl+Shift+R

Ctrl+Shift+T
Ctrl+Shift+D

Ctrl+Shift+L

Ctrl+Shift+O

Ctrl+Shift+W

SUILD
VIAP
ER]

mnplates

(@ Data Source Manager | Vector

.

et
% Raster
R Mesh
 Point Cloud
4 Delimited Text
§¥ Geopackage
U GPS
7 4 Spatialite
& PostgresQl
% MS SQL Server
Orade
Virtual Layer

* SAP HANA

&2 wms/wwmrs

WFS / OGC AP -
# Features

ﬁ WS

XYZ

g Vector Tile

@) ¢ ArcGIS REST Server
* GeoNode

Metadata Search

Coordinate

® File _ Directory | ) Database (| Protocol: HTTP(S), cloud, etc.

Encoding
Source

Vector Dataset(s) D:\Day- I hp
~ Options

Consult ESRI Shapefile driver help page for detailed explanations on options

ENCODING

DBF_DATE_LAST_UPDATE

ADJUST_TYPE <Default>

ADJUST_GEOM_TYPE <Default>

AUTO_REPACK <Default>

DBF_EOF_CHAR <Default>

It's OSM'’s Birthday! Please donate to support its future.
OpenStreetMap (OSM) is free to use, but not free to run. The QGIS user

experience is tremendously improved thanks to OSM data, tiles, geocoding, and
other services. OSM depends on donations from people like you! Double-click

this entry to learn how to support OSM's continued stability, quality, and
independence.

New Empty Project

EPSG:4326 - WGS 84

X Scale :44781436 ~

& Magnifier 100% < Rotation 0.0°

2| V| Render €EPSG:4326

Automatic

Close Add
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(@ *Untitled Project — QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
BatlOR HK-8--% GEFIB-=- =

DEARRH
L.L A2

B 2/ z

FerrRPP R

@ & @

®R ~2¢ B

Browser
oagy®o
~ Favorites
» [I") Spatial Bookmarks
» [8] Home
» 0] G\ (SYSTEM)
» ] DA (DATA)
@ GeoPackage
/7 Spatialite
@ postgresal

W Ms saL Server
@ Oracle

@ WMS/WMTS
B Vector Tiles
XV7 Tiles

&5!93?55\3’&55

>
Layers L]
YANEEYRAO

v © HistoricalT: iE

Q Type to locate (Ctrl+K)

@ *DemoWebMap.qpz — QGIS
Project Edit View
DB EQ‘ @ Data Source Manager

Create Layer

LL AL
Add Layer
Browser !
Vi ey Embedlayersand Groups..
= /¢ Favoriter Add from Layer Definition File...
B2 |» 1" Spatial £ 1 Georeferencer...
9, |* B¥Projecth 3 Copy style
Z | [8] Home
|, e svs! Paste Style
? A
» [ DA (DAT B Copy Layer
R, | @ GeoPadi [ Paste Layer/Group
R V4 Spatialit % Open Attribute Table
<
@ | Wrosoet L bute Table
@ B s sal / Toggle Editing
@~ | @ o0rde |1} Save Layer Edits
@ WMSW * Current Edits
B Vortar T Save A
Layers VRS

ast ‘ Save As Layer Definition File...

"1 Remove Layer/Group

L] Duplicate Layer(s)
Set Scale Visibility of Layer(s)
Set CRS of Layer(s)
Set Project CRS from Layer
Layer Properties...
Filter...

i Labeling

©Z Show in Overview

©0 Show All in Overview

Q Type to locate (Qr\‘ Hide All from Overview

R

.. ..?0,. L4

° o

@

'S . :‘N& ’..t K

Coordinate| 81.6°,24° |9 Scale 151353488 ¥ | (@ Magnifier 100%

] Settings Plugins Vector Raster Database Web Mesh Progessing Help
OR H-B-&-

Crl+L

V; Add Vector Layer...

% Add Raster Layer

[ Add Mesh Layer...

9, Add Delimited Text Layer...
@, Add PostGIS Layers...

/% Add Spatialite Layer...

B Add MS SQL Server Layer...
@, Add Oracle Spatial Layer...

f6 B, Add SAP HANA Spatial Layer...

(V3 Add/Edit Virtual Layer...
) Add WMS/WMTS Layer...

€3 Add WCS Layer...
&) Add WFS Layer...

2 Add ArcGIS REST Server Layer...

HH, Add Vector Tile Layer...
93 Add Point Cloud Layer...
Add GPX Layer...

Ctrl+D

QE % 2

Ctrl+ShiftsV |

Ctrl+Shift+R

Ctrl+Shift+T
Ctrl+Shift+D
Ctrl+Shift+L

Ctrl+Shift+O

Ctrl+Shift+W

Bvevy &~

2o

%

</ Rotation 0.0

2|V Render €EPSGi4326 @

Ctrl+Shift+C

&

Ctrl+F

Coordinate| 0.1°,171.5° |95 Scale151353488 ~

& Magnifier 100%

/< Rotation [0.0®

$!V Render @EPSG:4326 @
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(@ Data Source Manager | Raster = [m] X

Source Type

® File Protocol: HTTP(S), doud, etc.

W e -
4% Mesh Raster dataset(s) |D:\Day-3ExampleDataset\wsiearth. if a
 Point Cloud v Options
0 Consult GTiff driver help page for detailed explanations on options
& Delimited Text
2 NUM_THREADS
i GeoPackage GEOTIFF_KEYS_FLAVOR | <Default> =

GEOREF_SOURCES

74 Spatialite SPARSE_OK <Default> =

& PostgresQl

s MS SQL Server
%, Oracle

WA virtual Layer
¢ SAP HANA

WMS/WMTS

WFS / OGC API -
# Features

& WCs
*
% Vector Tile
@) ACGIS REST Server

& GeoNode

- Close Add Help

DEERRE 022901 PRA

BV ZAWBEB ~ - - @ & ® 2¢ B
Browser (1)
Vo nevze

Favorites s

» [I"] Spatial Bookmarks
» [ Project Home
» [8] Home
» [J C\ (SYSTEM)
» [ DA (DATA)

@ GeoPackage
[} / Spatialite
e @ postgresal
1 SAP HANA
@~ P Ms saL Server

X @ Oracle

@ WMS/WMTS

EH Vartar Tilos
Layers
sARw  rARD
>V " wsiearth

V' @ HistoricalTsunamiEvents

«

8
®

Coordinate 82.6°,86.9° % Scale 151353488 v | @ Magnifier 100% </ Rotation 10.0° 2V Render €®EPSG:4326 @

You can rename the layer name wsiearth to World Map and reorder the layers
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(@ *DemoWebMap.qpz — QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DDBEGRY Q22PN L o 8 tNOR H-8-R-5 QEH¥ZE-=-
BV ZWEQD 4 sl Wl o ®R €
Browser CE
Vo lnerae
, Favorites S
B2 » " Spatial Bookmarks
%> [¥ Project Home
7" [6] Home
x/" » [7] C\ (SYSTEM)
< |» [ DA (DATA)
%~ | @ Geopackage
@R / Spatialite
) @ postgresal
@ ill: SAP HANA
@- P Ms saL Server
@ Oracle

@ WMs/WMTS
B Vortar Tilos
Layers
“ASE =3 vl
V' @ HistoricalTsunamiEvents
» vV = World Map

Ctrl+K) Coordinate| 75.7°,172° | Scale 151353488 v | @ Magnifier 100% < Rotation 0.0 ° 3V Render @EpSGia326 @

Please Check/Uncheck the layers to make visible/invisible in the Map Canvas.

™M
N 4“
e i
5]

W Day-3ExampleDataset
sunami historical B WORK

B This PC

2 SYSTEM (C)

= DATA (D)
B8 Network
X
Y
®
Y L]
e
File name: | DemoWebMap .
Save as type: |QGZ files (*.qg2)
L]
e L]

A Hide Folders Cancel

Coordinate 68.6°,-134.9° | Scale 121433528 ~ | @@ Magnifier 100% % Rotation 0.0° |3V Render @EPSG:4326 @

2) We will now create a map in QGIS that looks and behaves just like we would like in
the web map. The plugin qgis2web will use replicate the QGIS settings and
automatically create the web map without us knowing about web mapping libraries.

When a user clicks on a HistoricalTsunamiEvents marker, we want an info-window
to display useful information about the HistoricalTsunamiEvents information. This
information is already present in the attribute table of the HistoricalTsunamiEvents
layers. Right-click on the HistoricalTsunamiEvents layer and select Properties.
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(@ *DemoWebMap.qpz — QGIS

Project Edit View Layer Set 5 Zoom to Layer(s)

0 mE e (O Zoomtoselection
: | © Show in Overview
RQeV.ZwBB | °
Show Feature Count
Browser
V; lnerae 5 Show Labels
o, ¢ Favorites Copy Layer
A |» " Spatial Bookmarks|  Rename Layer
9, | B9 Project Home L] Duplicate Layer
2y = e [ B L.
» [ CA (SYSTEM) =
B |, o\ oam 5 Open Attribute Table
% 7| @ Geopackage J/ Toggle Editing
@ | / spatilite Filter...
@ Change Data Source...
@ MS SQL Server Set Layer Scale Visibilty...
@ @onde Layer CRS
@ WMS/WMTS Export
HE Vactor Tilac e
Layers tyles
@ O %% &~ | AddLlayer Notes..
storicalTsui _ Propert

Q Type to locate (Ctrl+K)

L0

= Q

b Web Mesh Processing Help
-8B

wy @

Coordinate -39.8°,174.8° % Scale 151353488 ¥

@ Magnifier 100%

< Rotation [0.0°

2V Render @EPSG:4326

Q

3) Switch to the Fields tab. You will notice the different attributes present in the layer.
Some of these aren't relevant to the users of our web map, so we can choose to

hide these.

We will keep the following fields and hide the others.

" Symbology
€3 Labels
€O Masks
N EDT

Diagrams

-
1

Fields

E Attributes Form
Joins

ﬁ Auxiliary Storage

@ Actions

, Display

C, Rendering

& Temporal
Variables

£ B Elevation

I\ Metadata

ﬁ Dependencies

f (2 Layer Properties — HistoricalTsunamiEvents — Fields
Q

| [® 7=

i (2 Layer Properties — HistoricalTsunamiEvents — Fields

=

fi Information
'{S‘ Source
¥ Symbology
8 €I Labels

€O Masks

w7 3D View

Diagrams

-
1

Id ~ Name Alias Type Type name Length Precision Ce Config
1230 ID Integer (64 bit)  Integer64 10 0 Not searchable, Do not expose...
YEAR Integer (64 bit) |Integert 10 0

1232 MONTH Integer (64 bit)  Integer64 10 0

1233 DAY Integer (64 bit)  Integer64 10 0

1234 HOUR Integer (64 bit)  Integer64 10 0

1235 MINUTE Integer (64 bit)  Integer64 10 0

1.26 SECOND Decimal (double) Real 23 15

1237 EVENT_VALI Integer (64 bit)  Integer64 10 0

123 8 CAUSE_CODE Integer (64 bit)  Integer64 10 0

1239 FOCAL_DEPT Integer (64 bit)  Integer64 10 0

1.2 10 PRIMARY_MA Decimal (double) Real 23 15

abc 11 COUNTRY Text (string) String 254 0

abe 12 LOCATION_N Text (string) String 254 0

1.2 13 LATITUDE Decimal (double) Real 23 15

1.2 14 LONGITUDE Decimal (double) Real 23 15

123 15 REGION_COD Integer (64 bit)  Integer64 10 0

1.2 16 MAXIMUM_WA Decimal (double) Real 23 15

Style ~ OK Cancel lﬁ;’\rpay
&R/ E
d ~ Name Alias Type Type name Length Precision Comment Configuration

123 20 WARNING_ST Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...
123 21 DEATHS Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...
123 22 DEATHS_DES Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...
123 23 MISSING Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...
123 24 MISSING_DE Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...
123 25 INJURIES Integer (64 bit)  Integer64 10 Not searchable, Do not expose via ...

Help




Click on Attributes Form under Layer properties Available Widgets enter Alias as
Focal Depth for FOCAL DEPT field and repeat the same for other field Names also
under Widget type, you can explore the other options available.

N
2 ' Information

')\:\\ Source

. 4 Symbology

L abc JET
€D Masks

N7 3D View

Diagrams

E Fields

Attributes Form

Joins

ﬁ Auxiliary Storage

s Actions
, Display
Q‘/ Rendering
a Temporal
Variables
:"I Elevation

l\ Metadata

E Dependencies

( Q Layer Properties — HistoricalTsunamiEvents — Attributes Form
Q

Autogenerate

* Available Widgets
~ [Fields

123 |p
123 YEAR
123 MONTH
123 DAY
123 HOUR
123 MINUTE
1.2 SECOND
123 EVENT_VALI
123 CAUSE_CODE
123 FOCAL_DEPT
1.2 PRIMARY_MA
abc COUNTRY
abc [OCATION_N
1.2 LATITUDE
1.2 LONGITUDE
123 REGION_COD
1.2 MAXIMUM_WA
abc ABE
1.2 IDA
1.2 SOLOVIEV
123 WARNING_ST
123 DEATHS
123 DEATHS_DES
123 MISSING
123 MISSING_DE
123 INJURIES
123 INJURIES_D
1.2 NAMACGC AL

v | Style ¥

X

~ | @ Show Form on Add Feature (global settings) ¥ |

v General

Alias Focal Depth| -
Comment
v/ Editable Reuse last entered value Label on top
v Widget Type
Text Edit N6
Multiline

HTML

v Constraints
Not null Enforce not null constraint
Unique Enforce unique constraint
Expression &
Expression description

Enforce expression constraint
v Defaults

Default value (5
Preview

Apply default value on update

OK Cancel Apply Help

4) Similarly set other fields to Hidden type. As you may have notices, there are other
field types available that allow us to set how the fields appear to the users of our
map, the other fields like below under Widget type select Hidden.

@
[
(1 Information

J\:\\ Source

¥ Symbology

€3 Labels

€8O Masks

N7 3D View

g .
4 Diagrams

E Fields

Attributes Form

Joins
ﬂ Auxiliary Storage
@ Actions
, Display

Q‘/ Rendering

Q Temporal

Variables

- ¥ Elevation

l‘ Metadata

E Dependencies

Layer Properties — HistoricalTsunamiEvents — Attributes Form

Autogenerate

* Available Widgets
123 MISSING_DE
123 INJURIES

23N HIRHES B
1.2 DAMAGE_MIL
123 DAMAGE_DES
123 HOUSES_DES
123 HOUSES_D_1
123 HOUSES_DAM
123 HOUSES_D_2
123 TOTAL_DEAT
123 TOTAL_DE_1
123 TOTAL_MISS
123 TOTAL_MI_1
123 TOTAL_INJU
123 TOTAL_IN_1
1.2 TOTAL DAMA
123 TOTAL_DA_1
123 TOTAL_HOUS
123 TOTAL_HO_1
123 TOTAL_HO_2
123 TOTAL_HO_3
abe field 46
abe field 47

Refations

Actions

~ Other Widgets
QML Widget
HTML Widget

- | Stle v

X
~ | @ |Show Form on Add Feature (global settings) ~
v General

Alias
Comment

v Editable Reuse last entered value Label on top

v Widget Type
Hidden N4

A hidden field will be invisible - the user is not able to see its contents.

v Constraints
Not null Enforce not null constraint
Unique Enforce unique constraint
Expression v ||E

Expression description

Enforce expression constraint
v Defaults

Default value €
Preview
Apply default value on update

OK Cancel Apply Help
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5) Select the Identify Tool . and click on any feature on the Map Canvas on the
right side you can see the Identify Results.

@ *DemoWebMap.qpz — QGIS - (=] X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
DEERRY OS2 LHPL pe 8 LUOR EK-8-R-5 QEXRXIB-=-§
R@QV.iZRB@R L/ % g -G SR ® 2¢ B
Browser o® Identify Results CL
o QevYzo ®EH G Gy B
L Favorites a Feature Value <
B » % spatial Bookmarks ~ HistoricalTsunamiEvents [12]
9, |* [ Project Home ~ COUNTRY INDONESIA
7, |* @ Home » (Derived)
2y [ICA(SYSTEM) » (Actions)
B oo (DATA) . 1D 1783
Y- @ GeoPackage Year 1948
@ |/ spatilite MONTH 6
& | Wrostgresal 3’8‘5.; :8
2 i SAP HANA
o | P MsSQL Server MINUTE 38
@~ SECOND 18.000000000000000
@ Oracle EVENT_VALI 3
@ wms/wmTS CAUSE_CODE 1
B Vactor Tilos = Focal Depth NULL
Layers 2® Primary Magnitude  6.300000000000000
vawTavaRQ COUNTRY INDONESIA
V ® HistoricalTsunamiEvents Location OFF NORTHWEST COAST
» v # World Map LATITUDE 6.000000000000000
LONGITUDE 95.000000000000000
Region Code 60
Max. Wave Height  NULL
SOLOVIEV 0
WARNING_ST NULL
DEATHS NULL
TOTAL_INJU NULL
» COUNTRY INDIA =
Mode Current Layer -
View Tre
Q. Type to locate (Ctri+K) Coordinate -25.6°,156.9° R Scale 224601264 ~ | (g Magnifier 100% < Rotation 0.0° 3 V Render @EPSGi4326 @

6) Click on Layer Properties of HistoricalTsunamiEvents and select Symbology

=3 Layer Properties — HistoricalTsunamiEvents — Symbolog D&
~ F Y1 y
Q E Single Symbol -
fz Information ~ ® Marker &
5 @ Simple Marker
Q Source
(/( Symbology ®
€3 Labels
€O Masks
& 30 View coor | -
% Diagrams Opacity 1000% 2| €]
B ricics Size |2.00000 2| Millimeters BK=!
E Attributes Form Rotation |0.00 © s €
Joins Q, Favorites a -~ | ¥
5,1 Auxiliary Storage ProjeCt Styles
B Actions Default

, Display

C/ Rendering

a Temporal

Variables dot black dot white dot blue dot green dot red

] ©) e @ ®

-

W Elevation

l‘ Metadata

ﬁ Dependencies

Save Symbol... |Advanced ¥

» Layer Rendering

Style ~ OK Cancel Apply Help

Select Graduated from the drop down list; Value as PRIMARY MA; Color Ramp as Turbo;
Click on Classify and finally Click Apply and OK
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{ () Layer Properties — HistoricalTsunamiEvents — Symbology X
Q = Graduated -
fi Information Value 1.2 pRIMARY_MA v |l €

‘t\\ Source

(( Symbology Symbol ° -

€ Labels |

& Masks Legend format |%1 - %2 ecision ;€3 |2 [V/] Trim

\" 3D View fahed Colog T
Coorramp C—

v
4 Diagrams
Classes Histogram

Symbol ¥ Values Legend
Attributes Form v e 0.0000 - 0.0000 0 - 0

v e 0.0000 - 0.0000 0 -0

v o 0.0000 - 6.7000 0 - 6.7

v e 6.7000 - 7.4000 6.7 - 7.4

v e 7.4000 - 9.5000 7.4 - 9.5

Q‘/ Rendering

c Temporal

Mode | #:EEqual Count (Quantile) ¥ Classes |5 =
Variables

Classify R'-i}‘ = | Delete All Advanced ¥
Elevation

n Metadata

E Dependencies

V| Link class boundaries

» Layer Rendering

il Syle L OK Cancel Apply Help

@ *DemoWebMap.qpz — QGIS = (=] X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DEERRX VLR LNPP QLB LIOR B-8--5

ROV ZREBEB L/ ~ 6 K =
Browser @®
Vo oerzne
, Favorites E:
B |» I spatial Bookmarks
9 > [¥ Project Home
*» |6) Home
’:f » [ CA (SYSTEM)
< |y [ DA (DATA)
% 7| @ GeoPackage

@R /£ Spatialite
Y @ postgresal

& i SAP HANA
3
@- W Ms sQL Server
@ Oradle
® wms/wMTs
B8 Vactor Tile be

vV ®74-95
» v ¥ World Map

Q Type to locate (Ctri+K) Coordinate -72.5°,79.6° % Scale 151353488 ¥ | g Magnifier 100% < Rotation 0.0° 3 V Render @EPSG:4326 Q

Now, Click on the Symbol under Layer List of Historical Tsunami Events to change the
color.
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Q@ *DemoWebMap.qpz — QGIS

DR 0N
RQVAREBR L/

Browser 8®
R & )
/7 Favorites
» "] Spatial Bookmarks
» [ Project Home
» [6] Home
» [0 C\ (SYSTEM)
» [ DA (DATA)
7| @ GeoPackage
/ Spatialite
@ postgresal
il SAP HANA
P Ms saL Server
@ Oracle
@ WMS/WMTS
BH Vartar Tiloc

BIDBABNRAES

Layers e
¢AwTivRAQ
~ V ! HistoricalTsunamiEvents
v ®0-0
v ®0-0
v ©00-67
Ve 67-74
v ®74-95
» v ¥ World Map

R BatOOR H-8-G-5% @QE¥I B
=4 Ra ®

@ symbol Selector

~ ® Marker
® Simple Marker

Color

Opacity e——100.0 % |+
Size 2.00000 2| Millimeters
Rotation |0.00 ©

), Favorites

Project Styles
Default

oK Cancel Help

Coordinate| -34.4°,174.3° | Scale'151353488 ~ | & Maanifier| 100%

Q Symbol Selector

v @ Marker
@ Simple Marker

|
coor | - -

Opacity = ] 100'0 0/0
Size 2.00000 % | Millimeters

Rotation 1 0.00 °
Q, Favorites

Project Styles
Default

OK Cancel

&

- —

v E

0o

Help

<! Rotation 0.0°°

2V Render @EpsG:a326 @

Select the Color Red and Click OK. Now the Major Tsunami Events of Magnitude 7.4 —
9.5 has changed to Red Color Symbols on the Map Canvas.
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(@ *DemoWebMap.qpz — QGIS — o X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRRY IPALAPPI KIBRLIOR H-8--0 RE#TB-=-0 6~
RQViZARBB L/ z z =e 8= R 2¢ H
Browser B8

Vo lnevae
B | ravorites
B2 |» [I" spatial Bookmarks
9, |* [ Project Home
» [8] Home

g » [J CA (SYSTEM)
t. » [] DA (DATA)

o~ | @ GeoPackage
@ / Spatialite
@ | W rostgresal
@ P HANA
@ MS SQL Server
@ Oracle
@ WMS/WMTS
B Vortar Tiles

Layers a®
vaAww rRAO

~ V . HistoricalTsunamiEvents
®0-0

@©o0-0
00-67
©67-74
® 74-95
World Map

v
v
v
v
v
v

Coordinate| 57.7°,74° | W Scale151353488 ~ | {@ Magnifier 100% | & Rotation (0.0° |3 V| Render @EPSG:4326 @

7) Now we are ready to export our project to a web map. Install the qgis2web plugin
by going to Plugins » Manage and Install Plugin (See Using Plugins for more details
on installing plugins in QGIS). Once the plugin is installed, go to Web » qgis2web
» Create a web map.

| @ Plugins | Not installed (1137)

Q. QGIS2Web

qgiszweb

Export to an Openlayers/Leaflet webmap

@*‘m X

It replicates as many aspects of the project as it can, including layers, styles (including categorized and
graduated), and extent. No server-side software required.

' 503 rating vote(s), 924638 downloads

# Settings

Tags html, web, openlayers, export, leaflet, webmap, javascript, webmaps, css, ol3,
mapbox gl js
More info homepage bug tracker code repository
Author Tom Chadwin, Riccardo Klinger, Victor Olaya, Nyall Dawson
Available version (stable) 2.15.0 updated at Mon Jun 15 09:11:45 2020

Upgrade All | Install Plugin

Close Help

qgis2web generates a web map from your current QGIS project, either as OpenlLayers, Leaflet, or Mapbox GL J5.
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| @ Plugins | Not installed (1137) X

Q, QGIS2Web
&

qgis2web

ﬁ Motinstalled Export to an OpenlLayers/Leaflet webmap

qgis2web generates a web map from your current QGIS project, either as OpenLayers, Leaflet, or Mapbox GL JS.
Install from ZIP It replicates as many aspects of the project as it can, including layers, styles (including categorized and
graduated), and extent. No server-side software requirad.

[t g

* Settings

503 rating vote(s), 924638 downloads

Tags htmi, web, openlayers, export, leaflet, webmap, javascript, webmaps, css, ol3,

(22 QGIS Python Plugin Installer X

bug tracker code repository
n, Riccardo Klinger, Victor Olaya, Nyall Dawson

= = . ted at Mon Jun 15 09:11:45 2020
Installing plugin: qgis2web

Downloading data...

I 1%
Abort
Upgrade All | Install Plugin
 Close | 7 Help i\
| (3 Plugins | Not installed (1136) X
Q. QGIS2Web a
-

E 1 Installed qgisZweb

i Notinstalled Export to an Openlayers/Leaflet webmap

qgis2web generates a web map from your current QGIS project, either as OpenLayers, Leaflet, or Mapbox GL
Install from ZIP JS. Tt replicates as many aspects of the project as it can, including layers, styles (including categorized and
graduated), and extent. No server-side software required.

* Settings

503 rating vote(s), 924638 downloads

Tags web, webmap, webmaps, leaflet, openlayers, ol3, mapbox gl js, html,
Javascript, css, export

More info homepage bug tracker code repository
Author Tom Chadwin, Riccardo Klinger, Victor Olaya, Nyall Dawson
Installed version 3.15.0
Available version (stable) 3.16.0 updated at Mon Jun 15 09:11:45 2020

Changelog 2020/06/15 3.16.0 Mapbox GL JS 1.11.0, Leaflet raster zIndex, Leaflet filtered
labels, Leaflet filter with special characters in column name, OL centre on layer
search result
2020/06/01 3.15.1 Fix Leaflet XYZ layers
2020/05/29 3.15.0 MBGLJS measure, remove MBGLIS match CRS, MBGLIS
geolocate, MBGLIS address search, Leaflet XYZ without zmin, OL geocoder
2020/05/15 3.14.0 MBGLIS 1.10.0, MBGLIS fixes, OL projection, OL
geolocation, OL address search, OL measure, OL layer search
2020/04/08 3.13.0 Leaflet 1.6.0, OL 6.3.1, MBGLIS layer list colours, MBGLIS
layer list order, MBGLIS pseudoclasses, MBGLIS layer with no fields, Leaflet
field label apostrophes, MBGLIS field label apostrophes, MBGLIS style error, OL
CRS, Leaflet WMTS, Leaflet XYZ/WMTS layer order, OL field name
apostrophes, Autolinker slowdown
2020/01/13 3.12.1 OL no labels, Travis
2020/01/10 3.12.0 Mapbox GL JS layers list, processing algorithm error,
shorten popup links, OL label colour
2019/10/30 3.11.0 Mapbox GL JS popups, popup value localization (thanks,
Alasdair Rae!), Leaflet clear filter alignment, Leaflet pattern fill hover
2019/10/30 3.10.0 Mapbox GL J5 background colour, apostrophes in Leaflet
filters, popup images, Mapbox GL ]S XYZ tiled rasters, Leaflet filter reset,
Leaflet date filter, Leaflet null records in filters, Mapbox GL 1S layer zIndex,
autoclose Leaflet filter date picker, correct changelog

2019/10/18 3.9.0 Experimental Mapbox GL JS support, Leaflet labels with s
Upgrade All | Uninstall Plugin Reinstall Plugin
| Close | " Help
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Go to Menu = Web - qgis2web = Click on Create Web Map

(Q *DemoWebMap.qpz — QGIS = (=] X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help
DEERRE OLPPRPPHAQ WetaSearch @ s E-=-s
qgis2web
ARV ZAREB L/ - z R 20
Browser 1)

Vo nerae

L2 Favorites S
B2 | I Spatial Bookmarks

9, | B Project Home

2 [6] Home

VE’ » ] C\ (SYSTEM)

X5 |» [ DA (DATA)

®, v | @ Geopackage

@ / Spatialite

() @ postgresal

%
@

W Ms sQL Server

@ Oracle

@ WMs/WMTS

EH Voctar Tiloe >
Layers. a8
“ANT L rRAO
~ V . HistoricalTsunamiEvents
®0-0
®o0-0
00-67
©67-74
®74-95
World Map

v
v
v
v
v
A

Q_ Type to locate (Ctri+K) Coordinate| -72°,-109.5° | Scale 151353488 v | (@ Magnifier 100% || Rotation 0.0° &/ Render @EPSG4326 @

@ Export to web map X

Layers and Groups Appearance Export Settings Help

~ Layers and Groups -
¥ D HistoricalTsunamiEvents

Visible

Popups v

Cluster

Popup fields
D no label S
YEAR no label =
MONTH header label N
DAY no label N
HOUR header label X
MINUTE no label -
SECOND header label >.
EVENT_VALI no label ¥
CAUSE_CODE | no label =
FOCAL_DEPT  |no label >
PRIMARY_MA | no label Z
COUNTRY no label ¥
LOCATION_N  |no label x
LATITUDE no label =
LONGITUDE no label A
REGION_COD  no label v
MAXIMUM_WA no label >
SOLOVIEV no label X
WARNING_ST |no label -
DEATHS na lahal v ¥

o @ OpenLayers v Leaflet Mapbox GL JS Update preview Export <« »

8) Select OpenlLayers option and Click on Update Preview and Under Layers and
Groups = Pop fields — change it to inline label for all the fields.
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[Q Export to web map x

Layers and Groups Appearance Export Settings Help

~ Layers and Groups B
~ VD HistoricalTsunamiévents

Visible v

Popups v

Cluster

Popup fields
D inline label -
YEAR inline label -
MONTH inline label -
DAY inline label -
HOUR inline label -
MINUTE inline label -
SECOND inline label -
EVENT VAL inline label v
CAUSE_CODE  inline label -
FOCALDEPT inline label -
PRIMARY_MA inline label -
COUNTRY inline label -
LOCATION N inline label -
LATITUDE inline label -
LONGITUDE inline label -
REGION_COD inline label -
MAXIMUM WA inline label -
SOLOVIEV o label -
WARNING_ST  inline label -
NEATHS inlina lahal v Y

o @ OpenLayers o Leaflet Mapbox GL JS | Update preview Export < >

What is Leaflet?

Leaflet is an open source JavaScript library for mobile-friendly interactive maps. It is
developed by Vladimir Agafonkin of MapBox with a team of dedicated contributors.
Weighing just about 30 KB of gzipped ]S code, it has all the features most developers ever
need for online maps.

What is OpenLayers?
An opensource javascript library to load, display and render maps from multiple sources
on web pages.

@) Under Appearance - Check the check boxes as below.

(@ Export to web map X

Layersand Groups ~ Appearance  Export  Settings  Help

~ Appearance

Add address search

Add layers st Collapsed -
DEATHS: int: HistoricalTsunamiEvents
LATITUDE: real: HistoricalTsunamiEvents
ID: int: HistoricalTsunamiEvents
PRIMARY_MA: real: HistoricalTsunamiEvents
COUNTRY: str: HistoricalTsunamiEvents
MAXIMUM _WA: real: HistoricalTsunamiEvents
WARNING_ST: int: HistoricalTsunamiEvents

Geolocate user

Highlight on hover

Match project CRS v/

Measure tool Metric -
Show popups on hover V'

Template canvas-size -
Widget Background -
Widget Icon .

~ Scale/Zoom
Extent Canvas extent >

Max zoom level 28 =

Min zoom level 1 >
Restrict to extent S e

o @ Openlayers W Leaflet Mapbox GL IS Update preview Export < >
ragc 1< Ul 1O




10) Select Folder for Data export of the QGIS Web Map Project

(2 Export to web map

Layers and Groups Appearance Export Settings Help

~ Data export

Exporter Export to folder ~

Minify GeoJSON files v

Precision maintain =
® {2 OpenlLayers w Leaflet Mapbox GL JS Update preview Export

11) Click on Export and wait until the Progress is completed and Click OK.

Layers and Groups Appearance Export Settings Help +
~ Data export =
Exporter Export to folder ~ | .. [ ]
Minify GeoJSON files v/
Precision maintain -
QR
@ Progress
Creating OpenLayers map...
Exporting librarles... done
Exporting layers...
Exporting World Map as raster...
Exporting World Map to PNG... done
Exporting HistoricalTsunamiEvents to JSON...
done done
Writing HTML... done
Writing Layer Search... done
Success
Exported to D:/QGIS2Web
OK Cancel
i
— e
o @ OpenLayers ¥ Leaflet Mapbox GL JS Update preview Export 4 >

Page 15 of 18



12) Automatically the web map will be opened on your internet browser.

& indexhtml x + v - fu]) b4

€« > C @ File | D/QGIS2Web/qgis2web_2023_11_21-22_34_30_841826/index html Q2@ % OB & » 0 8 H

13) Mouse Over/ Click on any feature, a Popup will be displayed with the Identify
Results.

& indexhtml 5t + v - o 5

& > C @ File | D/QGIS2Web/qgis2web_2023_11_21-22_34_30_841826/index.htm| Q2 % OO B e x»0O 8 H
. . > g

s

1D:

Year:

MONTH:

DAY:

HOUR:
MINUTE:
SECOND:
EVENT_VALI:
CAUSE_CODE:
Focal Depth:
Primary
Magnitude:
COUNTRY: INDONESIA
Location:

SW.
SUMATRA
LATITUDE: -1
LONGITUDE: 975
Region Code: 60

Max. Wave 7

Height:
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* He BewdP :

R

- C @ File | D:/QGIS2Web/qgis2web_2023_11_21-23_01_19_371286/index.htm|

HistoricalTsunamiEvents

®67-74
®74-95
World Map

14) The qgis2web plugin has many limitations and it cannot do everything that the
powerful web mapping libraries OpenLayers and Leaflet can do.

This process can act as the starting point in your web mapping process and save
you valuable time by creating a basic template from which you can further
customize the web map. To highlight the fact that the output created from this
process can be readily changed to suit your requirement.

On your computer, go to the folder where the web map was exported. Locate the
resources folder.

“C:\Users\Administrator\AppData\Local\Temp\qgis2web”

15) Locate the line where the map.getView().fit() function is called and add the
following code after that. This new line of code instructs the web browser to center
the map on the coordinates of India. Save the changes to the qgis2web.js

map.getView().fit([20, -80, 140, 30], map.getSize());

Refresh your browser and see that the web map will load with India at the center.
This is a trivial example, but you can see how you can use any function available
in the OpenLayers or Leaflet libraries to customize the web map.

16) The exported map resides on your computer. While you can see it in action, it is
not very useful since you cannot share it anyone.

For others to be able to see the map, you need to upload it to a web server. While
the upload process will vary on the type of server you have access to — a cheap
and easy way to publish your map on the web would be to use any of the public
cloud storage services.
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Other Case Studies
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